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NOTICE
This document contains information about one or more ABB products and may include a description 
of or a reference to one or more standards that may be generally relevant to the ABB products. The 
presence of any such description of a standard or reference to a standard is not a representation that 
all of the ABB products referenced in this document support all of the features of the described or ref-
erenced standard. In order to determine the specific features supported by a particular ABB product, 
the reader should consult the product specifications for the particular ABB product.

ABB may have one or more patents or pending patent applications protecting the intellectual property 
in the ABB products described in this document.

The information in this document is subject to change without notice and should not be construed as 
a commitment by ABB. ABB assumes no responsibility for any errors that may appear in this document.

Products described or referenced in this document are designed to be connected, and to communicate 
information and data via a secure network. It is the sole responsibility of the system/product owner to 
provide and continuously ensure a secure connection between the product and the system network 
and/or any other networks that may be connected.

The system/product owners must establish and maintain appropriate measures, including, but not lim-
ited to, the installation of firewalls, application of authentication measures, encryption of data, installa-
tion of antivirus programs, and so on, to protect the system, its products and networks, against security 
breaches, unauthorized access, interference, intrusion, leakage, and/or theft of data or information.

ABB verifies the function of released products and updates. However system/product owners are ulti-
mately responsible to ensure that any system update (including but not limited to code changes, con-
figuration file changes, third-party software updates or patches, hardware change out, and so on) is 
compatible with the security measures implemented. The system/product owners must verify that the 
system and associated products function as expected in the environment they are deployed.

In no event shall ABB be liable for direct, indirect, special, incidental or consequential damages of any 
nature or kind arising from the use of this document, nor shall ABB be liable for incidental or conse-
quential damages arising from use of any software or hardware described in this document.

This document and parts thereof must not be reproduced or copied without written permission from 
ABB, and the contents thereof must not be imparted to a third party nor used for any unauthorized pur-
pose.

The software or hardware described in this document is furnished under a license and may be used, 
copied, or disclosed only in accordance with the terms of such license. This product meets the require-
ments specified in EMC Directive 2004/108/EC and in Low Voltage Directive 2006/95/EC.
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About This User Manual

General 
Any security measures described in this User Manual, for example, for user 
access, password security, network security, firewalls, virus protection, etc., 
represent possible steps that a user of an 800xA System may want to consider 
based on a risk assessment for a particular application and installation. This risk 
assessment, as well as the proper implementation, configuration, installation, 
operation, administration, and maintenance of all relevant security related 
equipment, software, and procedures, are the responsibility of the user of the 
800xA System.

User Manual Conventions
Microsoft Windows conventions are normally used for the standard presentation of 
material when entering text, key sequences, prompts, messages, menu items, screen 
elements, etc.

Feature Pack

The Feature Pack content (including text, tables, and figures) included in this User 
Manual is distinguished from the existing content using the following two 
separators:

Feature Pack Functionality ______________________________________________________________________

<Feature Pack Content>

___________________________________________________________________________________________
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Feature Pack functionality included in an existing table is indicated using a table 
footnote (*):

* Feature Pack Functionality

Feature Pack functionality in an existing figure is indicated using callouts.

Unless noted, all other information in this User Manual applies to 800xA Systems 
with or without a Feature Pack installed.

Roll-ups

The Roll-up content (including text, tables, and figures) included in this User 
Manual is distinguished from the existing content using the following two 
separators:

Application Change Management 5.1.4-1/1A Functionality______________________________________________

<5.1.4 RU1 Content>

___________________________________________________________________________________________

Application Change Management 5.1.4-2 Functionality______________________________________________

<5.1.4 RU2 Content>

___________________________________________________________________________________________

Warning, Caution, Information, and Tip Icons

This User Manual includes Warning, Caution, and Information where appropriate to 
point out safety related or other important information. It also includes Tip to point 
out useful hints to the reader. The corresponding symbols should be interpreted as 
follows:     

Electrical warning icon indicates the presence of a hazard that could result in 
electrical shock.
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Although Warning hazards are related to personal injury, and Caution hazards are 
associated with equipment or property damage, it should be understood that 
operation of damaged equipment could, under certain operational conditions, result 
in degraded process performance leading to personal injury or death. Therefore, 
fully comply with all Warning and Caution notices.

Terminology
A complete and comprehensive list of terms is included in System 800xA System 
Guide Functional Description (3BSE038018*). The listing includes terms and 
definitions that apply to the 800xA System where the usage is different from 
commonly accepted industry standard definitions and definitions given in standard 
dictionaries such as Webster’s Dictionary of Computer Terms. 

Released User Manuals and Release Notes
A complete list of all User Manuals and Release Notes applicable to System 800xA 
is provided in .

updated each time a document is updated or a new document is released. It is in pdf 
format and is provided in the following ways:

• Included on the documentation media provided with the system and published 
to ABB SolutionsBank when released as part of a major or minor release, 
Service Pack, Feature Pack, or System Revision.

Warning icon indicates the presence of a hazard that could result in personal 
injury.

Caution icon indicates important information or warning related to the concept 
discussed in the text. It might indicate the presence of a hazard that could result 
in corruption of software or damage to equipment/property.

Information icon alerts the reader to pertinent facts and conditions.

Tip icon indicates advice on, for example, how to design your project or how to 
use a certain function
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• Published to ABB SolutionsBank when a User Manual or Release Note is 
updated in between any of the release cycles listed in the first bullet. 

A product bulletin is published each time 
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Section 1  Introduction

Application Change Management
Application Change Management (ACM) is a version control tool used for 
engineering solutions in 800xA System. It is a configuration management system 
designed to handle configuration records. It also has a capability to be used as 
configuration change reporting system.

ACM is a client-server based system with communication access to 800xA systems. 
ACM configuration database is placed on the ACM server and stores metadata and 
configuring records.



Figure 1. Sample ACM View

Application Change Management Section 1  Introduction
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ACM is designed to track history and revisions of previously saved files. This helps 
users to revert to any version of a particular file, and identify the difference between 
any of the version of an entity with the entity in a 800xA system. Checkout of an 
object/entity ensures that no other user can submit changes to ACM system.

ACM supports System 800xA Entities and user-defined Custom Entities. Following 
are the System 800xA Entities types: 

• Control Project

• Control Application

• Control Diagrams
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• Controller

• HSE Subnet

• Library

The ACM client is used to configure the ACM server and perform operations such 
as CheckIn to ACM Server, CheckOut from Server, Get Latest and show 
version history. ACM provides configuration management capabilities for graphic 
displays, control libraries, control applications and controllers.

ACM is verified in context of: 

• 800xA HMI Configuration

• AC800M Configuration
• Fieldbus Configuration
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Entity Type Hierarchy 

The following entity type hierarchy of System 800xA are applicable for ACM work 
flows.

Library 

Library in System 800xA may consists of different Library Versions and Extension 
Libraries to hold different library components and aspects. For each major Library 
version, one .afw file will be created that will include both, different versions of the 
Library as well as the Extension Library/Libraries.

Control Project

Figure 3. Control Project

Control Project in System 800xA consists of Applications and Controllers folders to 
hold different applications and controllers configured in the same project.

Figure 2. Library Entity
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Each application consists of Application Types, Control Modules, Programs and 
Diagrams. An individual .afw file is created for each application that includes 
Application Types, Control Modules, and Programs. However, a separate .afw file is 
created for Diagrams as they are defined as separate entities.

Similarly all the controllers configured under the project are checked in as 
individual .afw files.

HSE Subnet

For HSE Subnet configurations, separate .afw files are created for individual 
Linking Devices, HSE Hosts and Links.

However, a single .afw file is created for HSE Subnet object configured in Control 
Structure.

Figure 4. HSE Subnet
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Custom Entity

Figure 5. Example of Custom Entity

Functions of ACM

• Check in, check out, get latest and compare on various levels of configuration 
records.

• Baseline for System 800xA configuration records and roll back to the required 
older baseline.

• Supports multiple versions of the objects.

• Supports Activity Log.

• Supports different access control privilege levels.

• Support for versioning at the object level.
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• Locking of configuration records with check out and check in.

• Provides separate error logs for troubleshooting.

• Support for connecting more than one 800xA system.

ACM System Configurations

Following are different possible configurations for ACM system:

Single System with ACM Server

Figure 6. Single System with ACM Server

Users are connected to a single system with ACM server. Apart from version tool, it 
is used to Baseline changes in order to package all changes from certain milestones.

Multiple System with Shared ACM Server

Figure 7.  Multiple System – Shared ACM Server

Users can connect to more than one 800xA system to the ACM server. It works as a 
common database which can be accessed by multiple system. Apart from version 
tool, it supports check out shared entities to dedicated systems in order to interlock 
check in from other systems. 
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Example Workflow:

In order to transfer checked in Entity or object of Aspect System A to Aspect 
System B, ACM client application of Aspect System B should be connected to 
System A using menu option Select ACM server.

Multiple System to Dedicated ACM Servers

Figure 8. Multiple System – Dedicated ACM Server

Users can connect more than one engineering system to dedicated ACM servers. It 
is used in replication of ACM server content through dedicated server to server 
connection allowing highly secure setup. Apart from version tool, it is used to 
Baseline changes in order to package all changes from certain milestones.

Example Workflow:

In order to transfer a checked in Entity or object of Aspect System A to Aspect 
System B, ACM client application of Aspect System B should be connected to 
ACM server of Aspect System A using server name and user credentials of Aspect 
System A in login window.

For the following types of ACM configurations:

- Single System with ACM Server. 
- Multiple System with Shared ACM Server. 
- Multiple System to Dedicated ACM Servers.

The 800xA systems and the ACM server requires secure communication if they 
are configured in different domain. Refer to Appendix E, Configuration of ACM 
Service in Different Domain Controller for more information.
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Prerequisites

Installation Prerequisites for ACM Client

• Microsoft SharePoint Client object model redistributable.

• ABB 800xA Base 5.1.0 or later versions. 

Add ACMClient.exe to the antivirus exception list on the intended 800xA node in 
order to proceed working with ACM.

 

Add the web browser to the antivirus exception list, and add the Microsoft 
SharePoint Foundation server weblink to the trusted sites of the web browser.

ACM Server Configuration

• Microsoft SharePoint Foundation 2010 SP2 (Download Microsoft SharePoint 
Foundation 2010 SP2 from www.microsoft.com). For more information, refer 
Appendix C, Installation and Configuration of Microsoft SharePoint 
Foundation 2010 SP2.

• Aspect system should be connected to the ACM server to transfer the data to 
ACM server.

Post Installation

Load the following system extension of ACM:

• ACM. 

• ACM for Engineering Studio.
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Before Check In

1. In Address bar of web browser enter the URL of ACM server central 
administration site. Following Application Management web page is 
displayed.

Figure 9. Application Management

2. In Application Management web page, click Application Management 
under Central Administration.
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3. Under Web Applications click Manage web applications. Following screen is 
displayed: 

Figure 10. General Settings
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4. Select Share point site which is used for ACM applications. For Example Share 
Point-80 and Click on General Settings. Following window is displayed:

Figure 11. Web Application General Settings

5. In Maximum upload size text box enter 2047.

6. Save and close the Web Application General Settings dialog box.
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Section 2  Basic Operation

Starting ACM for the First Time
Double-click the ACM Client icon from the Desktop to open the ACM Client user 
interface. Or, launch the ACM Client from Plant Explorer workplace. 

1. Select Environment window is displayed, select the environment and click 
OK.

Following login dialog box is displayed:

Figure 12. Login to Access

2. Enter the ACM Server URL in the Server URL field. For example, 
http://esl4vm03-acm
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3. To login to the ACM Server, do one of the following steps:

a. Select the Windows Login check box if you are logging in with the 
Windows credentials.

Or

b. Clear the Windows Login check box, type the user name and password in 
the respective text boxes.

For cross domain communication, Windows login will not work. For more 
information, refer to Appendix E, Configuration of ACM Service in Different 
Domain Controller

4. Click Login.

The ACM client screen is displayed with a message stating “ACM Server is not 
found. Please create ACM Server”.

5. Click OK.

6. In ACM Client menu, select Actions and click Create ACM System.

ACM System creation is a one time activity, which is confirmed with a success 
dialog box. 

7. Click OK to acknowledge the dialog box.

8. In the General Settings dialog, set the maximum number of versions and enable 
.xml compression and aspect support (if required). 

If General Settings are not required, click Close. This ensures that there is no 
limit on the maximum number of versions. For more information, refer General 
Settings on page 75.

 

If the login is performed selecting Windows Login option, then ACM Login 
window is not displayed on subsequent launch of ACM Client.

To Start the ACM Client from Workplace Application

Perform the following:

1. Open Engineering Workplace/Plant Explorer Workplace.

2. Select any entity from the structure browser preferably from Functional 
Structure or Control Structure.
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3. Right-click on the entity and point to ACM, and then select any option.

ACM server can also be accessed from a web browser by giving the specific URL 
of the ACM server. In the web page navigate to All Site Contents, and then select 
the required ACM system.
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User Interface

Figure 13. ACM Client User Interface

User interface of ACM client displays the Structure levels as in the aspect system. It 
also display the status bar, active user, connected aspect system and environment for 
the current operation. 

Table 1. User Interface of ACM Client

Number Description

1 Connected aspect system and environment

2 Menu bar

3 Object View pane
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The ACM client has four views to view the contents of the ACM server. Different 
views of ACM client are:
• Object Structure View
• Object View
• Version History View
• Status View

4 Entity name

5 Indicator

6 System in ACM server and Object Structure 
View 

7 Version History View pane 

8 Status View pane

9 Active User

10 Indicates if the connection to ACMServer is 
encrypted or unencrypted

In some cases, logged in user in ACMClient is displayed as SharePoint/System. 
To correct this, do the following steps in ACM Server:

1. Open SharePoint Central Administration from All 
Programs> Microsoft SharePoint 2013 Products.

2. Select Security > General Security> Configure Service 
Account.

3. Select the SharePoint Site (for example, Web Application 
Pool - SharePoint-80) and then select Network Service 
from the Select account for this component drop-down 
list.

4. Click OK.

Table 1. User Interface of ACM Client

Number Description
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Object Structure View

Figure 14. Object Structure

If an object or entity is assigned with the system name, then the icon 
representation of that particular object in the structure browser is similar to the 
root system icon in the ACM client.

If a whole library is checked in either from Object type structure or Library 
structure, it will be represented under the library structure folder in ACM client. 
All the object types are visible when the file is opened in Export/Import tool.

It is advisable to refresh the ACM client browser before performing any 
operation. 

The Object Structure view is used to view the object structure in ACM server. User 
can view the ACM server on an entity level. 

The entities are located in a tree structure on an entity level as displayed in ACM 
client.

Object View

Object view is used to view and perform various operations like check in, check out, 
view version history, delete entities, and so on.



Figure 15. Object View
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Indicators to display the status of the file:

•  – User has checked out (reserved) an object in ACM server and modifying 
the same object in Aspect system.

•  –File is checked in to the ACM server.

Show Version History: All versions of the selected entity is displayed in Version 
History View.

CheckIn to ACM Server - Check in saves a version of the selected entity from 
aspect system to the ACM server. For more information refer Check In an Object on 
page 49.
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CheckOut from ACM Server- Check out reserves the selected entity in ACM 
server.This is done to restrict any further operation on the same object unless it is 
checked in or undo check out is done. This is needed for a user who wants to work 
on the same object in engineering workplace. For more information refer Check Out 
and Edit Objects on page 58.

Undo Checkout: Undo check out releases the entity for other users on ACM server.

Delete: Deletes the selected file or object from ACM server. 

Get Latest: Get latest imports the selected file or object from ACM server to 
connected environment of 800xA System. For more information refer GetLatest on 
page 63. Get latest includes:

• With Dependencies: Entities are imported to the 800xA system with 
dependencies such as applications, libraries, and so on. All the existing data in 
the aspect system is overwritten in this operation.

• Without Dependencies: Entities are imported without dependencies.

It is recommended to perform GetLatest without dependencies if user is unaware 
of all the dependencies or if some of the dependencies are already available in the 
target system.

 

Compare with System: To compare the object in Plant Explorer with respect to the 
selected version in the ACM server. For more information refer Compare with 
System on page 60.

Double-click on object name to open the file in Import/Export tool to compare with 
the system. For more information on Import/Export tool, refer to the System 800xA, 
Maintenance (3BSE046784*). 

Deleting entities which are checked in as part of dependencies may result in 
failure of Get Latest with dependencies.

Deleting entities which are checked in as part of dependencies may result in 
failure of Get Latest with dependencies.
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Version History View

Figure 16. Version History View

Version history view pane is used to view different versions created for a particular 
file. Version history view helps the user to view and revert to earlier versions of the 
file and view the user who has made the changes for each file. For more information 
on version history refer Versions on page 64.
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Status View

Status View pane is used to view the status of the current operation such as check in, 
check out and other related information. Status View helps a user to understand if 
the files are checked in or checked out and also displaying the version numbers of 
the files, see Figure 17. 

Refer Table 2 for button description.  

Figure 17. Status View

Table 2. Button Description

Button Description

Opens all old messages in a separate 
text file.

Clears old status messages from the 
pane.

All the old messages get deleted on reopening the ACMClient.
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Menus

The menu bar of ACM client consists of:

• File on page 35

• Edit on page 35

• View on page 37

• Tools on page 44

• Actions on page 44 

• Help on page 46

File

The File menu consists of:

Refresh

To refresh the ACM client application.

Exit 

Closes the ACM client application.

Edit

The Edit menu consists the following: 

• General Settings

Opens the general settings dialog box with following option:

– Check in of objects along with .xml files.

– Creation and checking in .xls files for PG2 graphic displays.

– Set the maximum number of versions for objects/entity.

For more information General Settings on page 75.

• Custom Entity 

Opens a submenu with following options:
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– Configure: Opens the Custom Entity Configuration dialog. The dialog is 
used to define Custom Entities for the ACM server. Custom Entities can 
be defined and used in the ACM server. For more information refer 
Custom Entities on page 77.

– Update Local Copy: ACM client updates the user’s local copy available 
in the local system. It updates the local custom entities file with 
information from the server.

• Filter Settings

Opens the filter dialog for Aspect Categories and Object Types. For more 
information refer Filter Settings on page 84.

• Scheduler Settings

Opens the Scheduler Settings dialog for configuring Scheduler filters. For more 
information refer Configuring ACMScheduler Settings on page 90.



Section 2  Basic Operation Menus

2PAA108438-510 B 37

 

View

The View menu consists of Activity Log.

ACM Activity Log

Activity log is a separate view to display all the activities performed on 
respective ACM system, arranged in tabular form. Activities performed by 
different users are captured and displayed in ACM Activity Log.

Figure 18. User Activity Log

ACM Client will not respond for any of the ACM operations performed if the 
Activity Log window is kept open.

After creating a system baseline, the activity log is shown only for the date on 
which the baseline is created. All the previous logs are moved to the baseline.
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Application Change Management 5.1.4-2 Functionality______________________________________________

Exporting Activity Log to Excel Sheet 

It is possible to export the activity log from ACMClient to excel spreadsheet.

To export the activity log to an excel spreadsheet, do the following steps:

1. Open the ACM Client.

2. From the View menu, click ACM Activity Log.

3. To export the activity log to .xlsx file, click the Export All button, see 
Figure 19. The Save Activity Log dialog appears. 

Figure 19. UserActivityLog Dialog
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4. Select the TestACM.xlsx and click Save as shown in Figure 20.  

Figure 20. Save Activity Dialog

 

A message dialog appears on successful export, see Figure 21.
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5. Click Ok.

___________________________________________________________________________________________

Application Change Management 5.1.4-2 Functionality______________________________________________

ACM Server Info

This displays the database size of the SharePoint Site on ACM Server. It also 
displays the number of .afw files checked in to ACM Server.

This enables the user to track database usage and take corrective actions. 

To check the ACM Server database usage, do the following:

1. Launch ACMClient.

Figure 21. Message Dialog
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2. Click View and then select ACM Server Info as shown in Figure 22. 

Figure 22. ACMClient
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The data is displayed in status view as shown in Figure 22. 

___________________________________________________________________________________________

xml, xlsx and gz file count is displayed only if XML/XLS support is enabled.

Current storage used in ACM Server requires ACM owner role.

To do this: Change the logged in user from Action> Change ACM Server
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Tools

Tools menu consists of:

• Select Environment

Selecting the environment of the system in ACM server, to select Engineering 
or Production Environment.

• User Configuration

Opens ACM Server User Configuration dialog. Users can be added as 
member/removed from the members, in the ACM server. Refer To Give User 
Access on page 99 for more information.

• Select ACM System

Selects the system available in the ACM server.

Actions

The Actions menu consists of:

• Create ACM System

Creates a new ACM system for the 800xA system (aspect system).

Create ACM System is one time activity. one system (database) can be created for 
each aspect system in ACM server.

• Baseline

Opens a submenu with following options:

– Create BaseLine: Creating a baseline of the system in ACM server. It is 
used to Baseline changes in order to package all changes from certain 
milestone.

– Load BaseLine: Load baseline is used to load available baseline to the 
ACM client application.

For more information on baseline refer Baseline on page 67.

• Change ACM Server
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– This can be used to switch the user within the same ACM Server based on 
the requirement.

– This can be used to switch to a different ACM Server by providing the 
name and credentials of the intended ACM server in the respective 
fields. 

For connecting an ACM server which is configured in different domain 
controller, specified workflow has to be followed, refer Appendix E, 
Configuration of ACM Service in Different Domain Controller.
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Help

Help menu consists of:

• Help topics

Opens a context sensitive help page for the current view.

• About

Displays the latest version number of ACM.

Plant Explorer Context Menu

Using context menu in the Plant Explorer, users can perform check in, check out, 
get latest and compare operations. The ACM context menu entry appears when the 
selected object belongs to an Entity or a Custom Entity.



Figure 23. Context Menu in Plant Explorer
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• CheckIn to ACMServer - Check in with dependencies from the 800xA 
system to the ACM server. 

• CheckOut from ACMServer- Check out marks the selected entity as reserved 
in ACM server.

• GetLatest from ACMServer- Fetches the latest file version stored on the 
ACM server.

• Compare with ACMServer- Compare selected version from ACM server to 
the one in the system.



Version of an object/entity may not be created successfully in ACM server if 
check in operation is performed at the root level of Control Structure or 
Functional Structure. Therefore, user is advised to split such operations into 
multiple check in operations.

User with administrative privileges in ACM server can perform the following:

- Create ACM System operation.
- Create structures other than the default structures (control structure, functional 
structure, object type structure and library structure) in ACM Server.

Plant Explorer Context Menu Section 2  Basic Operation
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Section 3  Configuration

Check In an Object
Check in is done to save the snapshots of the objects such as projects, application, 
controllers and libraries and custom entities to the ACM server. After check in, the 
objects are visible in object view of the ACM client.  

To Check In an Object

1. Right-click on the required entity in object window pane of ACM client and 
click CheckIn to ACMServer.

If the Engineering solutions are transferred between two 800xA Systems, and if 
the target system does not contain same structure, then users have to take care of 
parent object (define parent object as Custom Entities). 

If Function diagrams, created using customized function diagram types are 
transferred between two 800xA systems, these types should be transferred before 
the function diagrams.

First time check in is done only from Plant Explorer context menu.

Check in at aspect level is not supported, so it must be performed only at the 
object level.

It is advisable to check the memory availability of the ACM database before 
checking in large projects. Refer To Check Database Size in ACM Server for 
more information.



To Check In an Object Section 3  Configuration

50 2PAA108438-510 B

 

2. Following confirmation message is displayed:

Figure 24. Check In Confirmation Message

3. Enter the check in comments (optional) in confirmation edit message box. If no 
comments are entered, ACM Client assigns a unique number based on the time 
stamp as comment. Select Include Children check box to include children. 

For Attach Change Request Document option refer to To Check In an Object 
on page 51.

4. Click Yes to check in or, click Cancel to cancel the check in.

5. If check in is successful, a message Check-in done successfully is 
displayed in Status View pane. 



Checked in application types will be displayed under the application folder of the 
control project.
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Simultaneous check in operations are not recommended. 

 

If the references of a control diagram are used in a graphic display, then check in 
of graphic display does not include the dependent diagrams. Check in the control 
diagram separately.

 

Perform the following to check in and GetLatest for the FF Libraries from the 
source system to target system:

1. Check in the FF Libraries from the source system.

2. Check in the HSE Subnet from source system.

3. Perform GetLatest for FF Libraries and run the FF upload.

4. Perform GetLatest of HSE Subnet.

For more information on FF Libraries refer System 800xA Device Management, 
FOUNDATION Fieldbus Configuration (3BDD012902*).

Application Change Management 5.1.4-2 Functionality______________________________________________

Check In with Change Request Document 

It is possible to check in an object/entity along with the Change Request or work 
order document. This can be used to track and link the configuration changes to the 
respective document that has introduced the particular changes. 

1. Right-click the required entity in object window pane of ACM Client and click 
CheckIn to ACMServer. 

2. The confirmation message window appears. Select Attach Change Request 
Document as shown in Figure 25.



Figure 25. Check In Confirmation Message
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The following options appear, Figure 25:

Browse: To attach a new change request document.

Lookup: To link the object, which is being checked in to an existing change 
request document available in the ACM server.

3. Click Lookup. The Lookup in ACM Server dialog appears which displays all 
the documents available in ACM Server, Figure 26. 

Figure 26. Lookup in Sharepoint

4. Select the required document from Lookup in ACM Server dialog and click 
Yes on the confirmation dialog to initiate the check in operation. The main 
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window is displayed and an icon under the Change Request column is updated 
against the checked in object as shown in Figure 27. 

Ensure that the change request document that is being checked in, is saved and 
closed before initiating the check in operation.

 

Figure 27. ACM Client Main Window
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5. Double-click the icon to open the checked in change request document.

To view the historical version, right-click the object and select Show Version 
History, Figure 28.

,  

Figure 28. ACM Client Version History Window

___________________________________________________________________________________________

Application Change Management 5.1.4-1/1A Functionality______________________________________________

Difference Check In

When performing multiple check in operations on an object, newer version of that 
object is checked in only if there is difference with respect to the earlier created 
version in the ACM server. Difference check is performed before every check in. 

For example: 

If first version of an object named Obj1 is checked in to the ACM server and user 
tries to create a second version of Obj1 directly without any modification, then 
check in does not create a new version as there is no difference with respect to the 
first version. The operation completes by displaying a message in the Status View 
stating “no afw data found”. 
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Similarly, When the Obj1 is modified without any modifications in the dependent 
objects (libraries/application types), check in of Obj1 does not create a new 
version of dependent objects but creates new version of Obj1. 

___________________________________________________________________________________________

Application Change Management 5.1.4-1/1A Functionality______________________________________________

Check In Support for Aspects Associated with an Object 

Using General Settings on page 75 of the ACM client, xml is checked in.

ACM check in feature has been extended to check in of aspects in .xml and .xlsx 
format. For Graphic aspects, .xlsx files are generated and for aspects that support 
IAfwBulkdata, .xml data will be extracted.

Check in of an object with special characters in it’s name may not work.
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For Graphic aspects, only .xslx files are extracted and checked in to the server. 

For the aspects categories listed below, .xml files are extracted and uploaded to the 
server:

• Trend Display 

• Log Configuration 

• FF Management aspect of Foundation Fieldbus

• Asset Optimization

• Control Connection aspects

• Trend Templates and Log Templates 

In General Settings on page 75 if include .xml data is No, then only .afw file is 
checked in to the ACM server.

The xml and xlsx data is stored in XMLData folder in the ACM server at the 
following location:

http://<ACMServerURL>/<800xASystem name>/XMLData.
 

Opening a checked in file located in the ACM server is possible only after the file 
is saved in the local drive of the 800xA system.

Check In of Asset Optimization (AO) Aspects 

If check in is initiated for objects having AO aspects, all the aspects are subscribed 
with the live values, and then the object is checked in to ACM server along with the 
.xml file of the corresponding AO aspect. Every time check in is done for objects 
having AO aspect, two files .afw and .xml files are created. The .xml file lists the 
properties of aspects and .afw file lists the properties of objects. If an object has 
multiple AO aspects, separate .xml file is created for each aspect. 

Before checking in the object, users have to define an object having AO aspects 
as custom entity if it is not a default entity. For more information, refer to Custom 
Entities on page 77.

A file/object that is checked in as a dependency to some other object in the ACM 
Server will not get deleted on performing delete action.
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Check In of Log Templates and Trend Templates 

If check in is initiated for objects having History Log and Trend Templates aspect, 
then the objects are checked in to ACM server along with the .xml file for the 
corresponding template aspect. Every time, a check in is performed for such objects, 
two files that is .afw and .xml files are created. The .xml file lists the properties of 
aspects, and the .afw file lists the properties of objects. On performing a subsequent 
check in of these templates without any modification, no .xml or .afw files will get 
checked in, and Status View pane displays “No xml data found and/or No afw data 
found” etc. in status messages. 

Check In of Foundation Fieldbus (FF) Management Aspects

FF Management aspects are associated with Foundation fieldbus configuration. All 
the objects underneath an HSE objects have FF management aspect to hold the 
configuration information. When an HSE object or any of its child is checked in to 
ACMServer, ACM extracts the FF Management aspect information in .xml format 
and checks in to ACM server. 

Check In of Log Configuration and Trend Display Aspects

If check in is done for an object having Log Configuration and Trend Display 
aspects, then the object is checked in to ACM server along with an .xml file. Every 
time a check in is done for Log Configuration and Trend Display aspect, two files 
.afw and .xml files are created. The .xml file list the properties of aspects, and .afw 
file lists the properties of objects. 

Check In of PG2 Graphic Aspects

If checkin is performed on an object having PG2 Graphic Display aspect, then the 
object is checked in along with the properties of PG2 graphic display aspect as a 
separate .xlsx file. If the graphic display includes any graphic element, the same also 

Before checking in the object, users have to define an object having Log 
Templates and Trend Templates aspects as custom entity if it is not a default 
entity. For more information, refer to Custom Entities on page 77. 

Before checking in the object, users have to define an object having Log 
Configuration and Trend Display aspects as Custom Entity. 
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gets extracted as a separate .xlsx file. This includes creation of .xlsx file along with 
the live values of its properties/elements.

The xml and xlsx data is stored in XMLData folder in the ACM server at the 
following location:

http://<ACMServerURL>\<800xASystem name>\XMLData.

Check in for an xlsx is done using General Settings on page 75 main menu.

 

___________________________________________________________________________________________

Application Change Management 5.1.4-1/1A Functionality______________________________________________

Check In Support for OPC Control Connection 
Control Connection aspects can also be checked in to the ACM server. When a 
Control connection aspect is checked in to the ACM server a .xml file gets created 
for the aspect and .afw file is created for the object.

If check in is initiated for objects having AO aspects, all the aspects are subscribed 
with the live values, and then the object is checked in to ACM server along with the 
.xml file of the corresponding AO aspect. 

Check Out and Edit Objects

To edit objects in 800xA system, user has to check them out. When user checks out 
an object, ACM marks that object as reserved in ACM server so that other users can 
be intimated. Other users can only view the object, but they cannot create any new 
version of the object until it is checked in or an undo check out is performed. If the 
user checks out an object that is linked to multiple locations in the ACM Server, the 
object is reserved in all the locations.

When check in is done, a separate utility in the backend extracts the graphic data 
and checks it in to the ACM server.

If an object has multiple aspects of category PG2, separate files get created for 
each aspect.
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To Check Out an Object

1. Right-click on the required entity in object window pane of ACM client and 
click CheckOut from ACM Server. Following ACM CheckOut dialog is 
displayed:.

Figure 29. ACM CheckOut

2. Select an option to get latest version of the entity. 

a. To perform get latest with dependency: Select the GetLatest With 
Dependency check box.

b. To perform get latest without dependency: Select the GetLatest Without 
Dependency check box

By default GetLatest With Dependency is selected. 

3. Click Yes to acknowledge and proceed with check out. Or, click Cancel to 
close the dialog box without check out.

A Message Selected object restored successfully is 
displayed in the Status View.

.

Get latest of checked out objects should be done from ACM Client application.

When check out is performed, the object is locked in the ACM Server and can be 
modified in Plant Explorer. 

ACM Client may not function as expected if the database of Microsoft 
SharePoint Foundation 2010 SP2 reaches a maximum limit of 4GB.
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Undo Check Out of an Object

Undo check out unlock’s the objects and discards the changes made to the object. 
The ACM server retains the last version of the object as the current version.

To Undo Check Out

1. Select the checked out object to which undo check out is to be done.

2. Right-click on the required entity in object pane and click Undo CheckOut. 

A dialog Are you sure you want to Undo CheckOut the 
selected Entity? is displayed. 

3. Click OK to undo the check out or, click Cancel to cancel undo check out.

___________________________________________________________________________________________

Compare with System

Compare with system, compares different versions of an object present in ACM 
server to the one present in 800xA system. User can compare any of the older 
versions with the one present in aspect system. Comparing with the system is done 
from Engineering Workplace or from ACM Client.

Compare results may not be proper if the object is moved from its original 
location in 800xA system.
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To Compare with a System:

1. Right-click on the required entity in an object window of ACM client and click 
Compare with System.

2. A Import/ Export window is displayed. 

Figure 30. Import Export View

3. Launch Difference dialog box from the View Menu or the Differences button 
in the toolbar.

4. From Show Differences dialog, select System and Environment from drop-
down list. Click Finish.



Figure 31. Difference Between

Compare with System can also be performed from Version History pane.
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Following Differences between window is displayed:

Detailed Difference Report

Difference report provides the differences between object or entities in the 800xA 
system with a particular version of the file in the ACM server. If any difference exist 
then the difference report provides a report indicating the additions, deletions, or 
modifications. For more details, refer to the System 800xA, Maintenance 
(3BSE046784*).
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GetLatest

Get latest imports the selected file or object from ACM server to connected 
environment of System 800xA. It is used to import the latest version or a historical 
version of an afw file to System 800xA. The GetLatest can be performed either from 
ACM Client or Workplace application.

To Perform GetLatest (from ACM Client):

1. Right-click on the required entity in object view pane of ACM client and select 
GetLatest.

2. Click on Without dependencies or With dependencies. Following warning 
message is displayed:

Figure 32. ACM Warning

GetLatest of an Application having Project Constants, should always performed 
with dependencies. This is to ensure that the Project Constants are imported to 
800xA system.

3. Click OK to continue to perform GetLatest or Cancel to abort GetLatest.

If GetLatest is successful, a message is displayed in the Status View.

F

If a Function Diagram is checked in with customized template, then GetLatest 
should be performed on customized template and then on other Function 
Diagrams.

 

GetLatest of a library must be performed only at the library level in Object Type 
Structure or Library Structure.

 

For GetLatest of a Custom Entity, it is advisable to open the object .afw file in 
Import/Export tool and compare it. Refer Compare with System.
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Versions

A version is a snapshot of an object at a particular time the object was checked in to 
the ACM server. A new version is created each time the object is checked in. 
Versions allows the user to keep track of the changes to an object. New version gives 
the object a higher version number.

To Display Versions of the Object:

1. Select any object in the Object View pane.

2. Right-click on the required entity and click Show Version History.

All the versions are listed in the Version History pane of the ACM Client. Double-
clicking on any version opens the Import/Export tool to show the contents of the.afw 
file.

To Revert to a Particular Version:

1. In the Version History pane of ACM Client select the version that need to be 
reverted.

2. Right-click on the version, select Revert to this version and do one of these:

– To revert to the version without dependencies, select Without 
dependencies.

– To revert to the version with dependencies, select With dependencies.

Revert to this version imports and modifies only those files which are included 
in a particular version.

Delete a Version/s from ACM Server

It is possible to delete a particular version/all versions of an object/entity from ACM 
server. 

The delete operation is allowed only to the member of Owner group in ACM Client. 
For more information on user configuration and permissions refer Security in ACM 
Server on page 97. 

Perform the following to delete version/s of an object/entity:
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1. Open ACM Client.

2. Select a object/entity from the Object View pane, right-click on it and select 
Delete (Figure 33).

Figure 33. Version History of an Object/Entity

 

3. On the confirm delete message, click Yes to delete the object, or No to cancel 
the operation.

The delete operation deletes all the versions of the object/s from ACM server.

Figure 34. Deleting the Object

Delete the Versions from Version History Pane

Perform the following to delete the versions from Version History pane:

1. Select the required version from the Version History pane.

2. Right-click on the version and select Delete this Version.



Figure 35. Deleting a Version
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Multiple versions of an object/entity can be deleted at the same time.

3. On the confirm delete message, click Yes to delete the version/s or else No. 

Figure 36. Confirm Delete
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Baseline

Baseline is the process of creating the snapshot of the complete system in the ACM 
server which cannot be modified in future. It is done to baseline the changes in order 
to package all changes from certain milestones. Once baseline is done, it can be 
used to revert back by loading the required baseline and performing GetLatest of the 
object/entity to the aspect system.    

After baselining an ACM system, all the historical versions of an entity or a 
custom entity will be archived including the activity log, while retaining only the 
latest version in the system. This is applicable from 5.1.4-1 release onwards.

User Activity Log for a previous date is not available after creating a baseline.

Creating a baseline is allowed only to an Admin user. The Admin user has to 
ensure that no further modifications or ACM operations are performed during 
baseline creation. This is aligned with System 800xA behavior where it is 
assumed that configuration changes are not performed while taking the system 
backup. 
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Create a Baseline:

To create a Baseline, do the following steps:

1. In ACM Client, select the system that needs to be baselined from the Object 
View pane.

2. Select Actions> Baseline> Create BaseLine. 

3. A dialog It is advisable to check-in all the objects/ 
entities before creating the baseline. Do you want to 
continue? is displayed, click Yes to continue with the baseline creation or, 
click No to cancel creation of baseline.

4. An ACM-Baseline dialog appears on click of Yes as shown in Figure 37. 

Figure 37. ACM Baseline Dialog

5. In the Name field, enter the user name.

Baseline name must not contain vertical bar characters. It is limited to 100 
characters.
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6. In the Description field, enter a brief description. 

Baseline description is limited to 150 characters.

Name and Description fields are available from 5.1.4-2 release. 

 

7. Click OK. 

8. If Baseline creation is successful, a message Baseline created 
successfully is displayed, click OK to acknowledge this message.

 Step 4 to Step 7 are applicable from 5.1.4-2 release onwards.

A baseline is created in ACM server with a name “Baseline_SystemName”, where 
the SystemName refers to ACM system name and can be verified in ACM server 
using web browser. However, post 5.1.4-2 release, baseline will have a user given 
name and description along with “Baseline_SystemName”.

Load a Baseline 

To load a Baseline, do the following steps: 

1. From the Actions menu, click Baseline.

2. Click Load Baseline. A Select Baseline dialog appears as shown in Figure 38. 
It lists all the available Baselines withe the following details:

– Name: user given name for baseline

– Description: user given description for Baseline

Load baseline loads the selected baseline in read only mode.
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– Baseline System Name: ACM generated name for Baseline. 

Figure 38.  Select Baseline Dialog

3. Click Select.

The selected Baseline is loaded.  

Delete a Baseline

To delete a Baseline, do the following steps: 

1. Log on to the ACM server on the web browser by entering a appropriate URL.

For example, http://esl4vm03

All the baselines created before updating to 5.1.4-2 will have the Name field 
empty whereas the Description field has ABB 800xA System by default.

During first launch of ACM client, Load baseline is not possible before creating 
or loading the ACM server.

All the baselines created before updating to 5.1.4-2 will have the Name field 
empty whereas the Description field has ABB 800xA System by default.
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2. Click All Site Content. 

Figure 39. SharePoint Options



Baseline Section 3  Configuration

72 2PAA108438-510 B

 

3. In Sites and Workspaces, click on the baseline that you want to delete. 

Figure 40. Selecting a Baseline
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4. Click Site Action and select Site Settings. 

Figure 41. Site Settings Option
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5. Under the Site Actions, click Delete this site.

Figure 42. Option for Deleting the Site

 

6. Click Delete to delete the site, else click Cancel to end the operation. 

7. Click OK on the confirmation message. The deletion of the baseline is 
complete and a confirmation message is displayed (Figure 44). 

Figure 43. Confirming the Delete Action
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8. Click Go back to site.

Figure 44. Go Back to Site Message

9. To delete more baselines repeat Step 2 through Step 8.

Application Change Management 5.1.4-1/1A Functionality______________________________________________

General Settings

General Settings are used to enable the check in support for aspects and .xml 
compression. Also it is used to configure maximum number of versions in ACM 
server. 

The General Settings dialog consists of the following options:

If General Settings are not required, click Close. This ensures that there is no 
limit on the maximum number of versions. Also, check in of separate .xml and 
xlsx files for supported aspects is disabled.



Figure 45. General Settings
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• IncludeXmlData

If Yes, then check in includes aspect data in .xml format. For more information, 
refer to Check In Support for Aspects Associated with an Object on page 55

• IncludeXlsData

If Yes, then check in includes the aspect data .xls format. For more information, 
refer to Check In of PG2 Graphic Aspects on page 57

• EnableCompression

If Yes, xml data is compressed before saving it in to the ACM server.

• MaxVersion

It is the maximum number of versions for .afw, .xml and .xls files in ACM server.

MaxVersions

MaxVersions is indicated by a numerical value and is set while creating ACM 
system in ACM Server. It is a one time setting and cannot be changed when working 
with ACM client. 

Follow the procedure to set a value for MaxVersion command while setting up ACM 
system:

1. During ACM system (creation) setup, General Settings dialog box is 
displayed.
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2. For the MaxVersion enter a value.

3. Click OK.

The number of file versions stored in the ACM server will be limited to the value set 
in MaxVersions. If many versions of the files are created in the ACM Server and the 
file version reaches the maximum versions set, then the oldest version of the file 
gets deleted automatically. 

___________________________________________________________________________________________

Custom Entities

Configure

Entities like projects, applications, controllers and libraries, and Control Networks 
can be exported to the ACM server without any special configuration. Checking in 
objects which are not part of an entity to the ACM server need to be defined in ACM 
as Custom Entities. 

Setting MaxVersions to 0 removes the limitation on the number of file versions.



Figure 46. Custom Entity Configuration
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For each object that is defined as a Custom Entity there are number of properties 
that can be defined.

• Include Children

All the objects located below the object describing the Custom Entity are included 
in the Custom Entity.

• Include Dependencies

All dependencies are included in the Custom Entity.

• Delete at import

It is not recommended to use this option.
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Entities like projects, applications, controllers and libraries, and Control Networks 
can be exported to the ACM server without any special configuration. 

The objects that are not entities can be defined as Custom Entities by adding them to 
a list from the ACM Client. This only has to be set up once and then the object is 
available for being exported to the ACM server. The order in the list defines the 
import order when imported to a system. 

To Add a Custom Entity

Perform the following to add a custom entity:

1. Navigate to Edit > Custom Entity > Configure. 

Figure 47. Custom Entity Configure Window

Objects are defined as Custom Entities by adding them to a list from the ACM 
Client. This only has to be set up once and then the object is available for being 
exported to the ACM server. The order in the list defines the import order when 
imported to a system.

If an object is defined as a custom entity and is renamed later, the user must add 
the newly named object to the custom entity again.
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2. Click Add in the Custom Entity Configuration dialog box.

Figure 48. Add Dialog Box

3. Select the required object from Add Custom Entity dialog box. See Figure 49.
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4. Click Add. 

Figure 49. Adding Custom Entity
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The object is added as a Custom Entity which is displayed in the Custom 
Entity Configuration dialog box.

Figure 50. Custom Entity Added
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5. Click Apply on Custom Entity Configuration dialog box. 

Figure 51. Applying the Custom Entity Settings

The object is defined as a Custom Entity in ACM and will have ACM context 
menu to perform ACM operations.

For each object that is defined as a Custom Entity there is a property that can be 
defined. 

• Delete at import

It is not recommended to set this option to Yes.
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Filter Settings

Aspect Category Filter

Figure 52. Aspect Category Filter

If the user does not want to overwrite the specific Aspect Categories (e.g. Operator 
Note) from the ACM server to the Engineering System, it can be configured using 
the Aspect Category Filter. 

To Set Aspect Category Filter:

1. From the ACM client menu select Edit>Filter Settings.

2. Click Aspect Category Filter tab

3. Add the required category to the filter and set one of the following properties:

– AlwaysFilterOut.

Do not import aspects of a specified category.

– NeverOverwrite.

Never overwrite aspects of a specific category.
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– OverwriteOlderAspects.

Overwrite aspects of a specific category if current modification date is 
older than the date in the destination.

The filter applies to the whole ACM server so that all imports from the ACM server 
to the system are filtered.

Objects Type Filter

If the user does not want to overwrite specific Object Types (e.g. HART Device 
objects) from the ACM to the Engineering System, that can be configured 
using Object Type Filter.

Figure 53. Object Type Filter

To Set Object Type Filter:

1. From the ACM client menu select Edit>Filter Settings.

2. Click Object Type tab.

3. Add the required types to the filter and set one of the following properties:
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– Always Filter Out.

Do not import objects of a specified type.

– Never Overwrite.

Never overwrite aspects of a specific object. But creates aspects of the 
specific object if it is not exist in the destination system.

– Overwrite Older Aspects.

Overwrite aspects of a specific object if current modification date of the 
aspect is older than the date in the destination.

The filter applies to the whole ACM server so that all imports from the ACM server 
to the system are filtered. 

Error Reporting

Import of entities continue even if some entity fails. The information about the 
failed entities are logged in the Status View pane.

Error logs are created only when exceptions occurs while working through ACM 
client. Error logs are not created in failed cases of GetLatest. 

Errors during check in / check out is reported to the user and written to a logfile. The 
logfile is viewed from the following location:
Local Disk (C:) >Users > user account > AppData > Roaming > ABB > ACM.

Application Change Management 5.1.4-1/1A Functionality______________________________________________

Database Management

Every file checked in to ACM server is given a version number and this number is 
incremental. The number of versions that a particular file can store in the ACM 
server is set using MaxVersion option in the General Settings during the ACM 
system creation (setup). Files stored in the ACM server are limited by the value set 
using General Settings. If the number of checked in versions of a particular file 
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exceeds the value set, then the first version of the file will get deleted from ACM 
server. The files are deleted by the First-in First-out method. 

___________________________________________________________________________________________

On performing GetLatest (refer To Check Out an Object on page 59) of an object 
whose dependent file version is replaced by latest version (as known that the 
maximum versions of a file are set using General Settings at the time of ACM 
setup.), an error message appears as shown in the figure below.
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Section 4  ACMScheduler

Application Change Management 5.1.4-1/1A Functionality______________________________________________

Introduction
ACMScheduler is used to synchronize the ACM system with corresponding aspect 
system. It identifies the differences between ACM server and aspect system and 
checks in the objects which are never checked in or has been modified after last 
check in.

Synchronization can be restricted to certain structure by proper configuration. 
However, Functional structure and Control structure are configured by default.

The ACMScheduler could be manually run through the command prompt as shown 
in Figure 54 or could be configured in Windows Scheduler to run on a scheduled 
basis. Every subsequent scheduled operation will check in only the changed data or 
the differences from last check in.
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Configuring ACMScheduler Settings

It is possible to either exclude or include the check in of any object or an entity 
during ACMScheduler operation. It is also possible to include an object or an entity 
that belongs to a structure other than the default or the configured structure for the 
scheduler operation. 

Exclude Object Filter

There is an option provided in the ACMClient application to exclude check in of an 
object during ACMScheduler operation. For example, if system has user created 
libraries, then these are considered as custom libraries and as a result they get 
checked in to ACMServer during automatic check in. Such cases may be applicable 
for other objects as well. If user does not want to check in those objects, the same 
can be excluded by using exclude object filter.

Figure 54. Running the ACMScheduler

These settings must be configured before running the ACMScheduler.
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To exclude an object during scheduler operation, do the following steps:

1. Launch ACM client.

2. Click Edit and then select Scheduler Settings as shown in Figure 55. 

Figure 55. ACMClient

3. In the Scheduler Settings window, select the Exclude Object Filter tab. 
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4. Click Add and browse through the structures to select the objects to be 
excluded for check in and click Apply, Figure 56.

  

Include Object Filter

By default, ACM checks in the objects from the Control Structure and the 
Functional Structure and takes in the dependencies from the Object Type Structure. 
To include objects from outside these structures, user must configure the Include 
Object Filter in the Scheduler settings. 

To include an object filter, do the following steps:

1. Launch ACM client.

2. Click Edit and then select Scheduler Settings, Figure 55.

Figure 56. Exclude Object Filter Tab
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3. In the Scheduler Settings window, select the Include Object Filter tab, 
Figure 57. 

Figure 57. Include Object Filter Tab

 

4. Click Add and browse through the structures to select the objects to be 
included for check in and click Apply. 

When the ACMScheduler starts, it creates the Systemdata.xml file that includes 
detailed information about the objects and entities of aspect system and saves it to 
the ACMServer. In order to indicate the user that ACMScheduler operation is going 
on, ACM changes the state of SystemData.xml file to Checked Out in ACMServer. 
The same is verified by an added arrow in the corresponding file as shown in 
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Figure 58. 

After the completion of the operation, ACM releases the checked out file to indicate 
the user that the Scheduler operation has been finished. As a result, the arrow 

Figure 58. Arrow indication in the Systemdata.xml File
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indication is no longer seen in the SystemData.xml file, refer Figure 59.

___________________________________________________________________________________________

Figure 59. Systemdata.xml File

The windows automatic task scheduler can also be used to schedule automatic 
check in operations periodically. This can be done using the standard procedure 
to configure the Windows Scheduler. For more information, refer to the following 
website: 

http://windows.microsoft.com

http://windows.microsoft.com
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Section 5  User Access and Security Settings

Windows login user always have higher priority over ACM Server user or 800xA 
user.

Security in ACM Server

If the user is not listed in ACM server User configuration, user should be added 
from the ACM server.

To work with ACM, user should be a member of one of the following group. User 
access and security settings are similar to Plant Explorer to avoid user conflicts with 
ACM. 

To add users in ACM Server

1. Launch ACM server site.

2. Click Site Actions > Site Permissions.

3. Select particular ACM user group and add users as per the privileges to be 
given.

Following are the different types of user groups available in the ACM server:

• ACM Server Owner.

• ACM Server Member.

• ACM Server Visitor.
.



Table 3. Permissions to work with ACM

Permission
ACM Server 

Member
ACM Server 

Owner
ACM Server 

Visitor

Configure ACM

Set Server

Set System

Update System

Update ACM Server

Create Custom 
Entity

Check in to ACM

Delete Entity

Get latest from ACM

Import to System

Select Server

Select Environment

Security in ACM Server Section 5  User Access and Security Settings
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Users configured as ACM Server Members do not have permission to create the 
ACM System.

Group users (operator or system engineers) of Engineering Workplace, having 
privileges as ACM Server Members in ACM, are restricted in starting the ACM 
client.
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To Give User Access

1. In ACM client, select Tools > User Configuration.

2. ACM Server User Configuration dialog is displayed.

Figure 60. ACM Server User Configuration

3. Click on a Group Name to which the user has to be added.

4. To add users, select users from Not Members and click Add button. Users are 
added in Members pane.
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5. To remove users, select users in Members pane and click Remove button. user 
are removed from the group and are displayed in Not Members pane.

6. Click Apply Changes to close the dialog.

Users can perform different operations based on the Group assigned.

Security in 800xA System
The 800xA Security model is based on extensions to Windows security model. For 
more information on System 800xA functions to administrate and set up security for 
your system refer to the System 800xA, Administration and Security 
(3BSE037410*).

Security using Internet Protocol Security
The Internet Protocol Security (IPsec) is a protocol suite for securing Internet 
Protocol (IP) communications by authenticating and encrypting each IP packet of a 
communication session. The purpose of IPsec Configuration Tool is not primarily to 
encrypt the communication, but to ensure through strong authentication, that only 
legitimate nodes connect to the 800xA System.

The IPsec Configuration Tool, allowing secure communication, can also exempt the 
nodes which are outside the 800xA System or the nodes that are not the Domain 
members. For more information refer System 800xA, IPsec Configuration Tool 
(2PAA107224*).

It is advisable to refresh user configuration window before performing multiple 
operations (add or remove users).
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Appendix A  Changing Default Port

ACM server by default communicates through 80 port of Windows Internet 
Information Services (IIS). In some scenarios, when some other application is 
configured on the same port, it may result in conflict and restrict the ACM server 
operations. In such scenario's, it is possible to configure ACM server on a different 
IIS port. Perform the following steps to change the default port of the ACM server:

1. Open Sharepoint 2010 Central Administration from Start menu and go to 
Application Management-> Manage Web Application.

2. Select default web application Sharepoint-80.
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3. Click Delete and select Remove Sharepoint from IIS website. Following 
dialog is displayed:

Figure 61. Remove Sharepoint From IIS Web Site

4. In Remove Sharepoint From IIS Web Site dialog, Select Yes to delete the IIS 
web site.
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5. In Web Application tab click Extend, the following dialog is displayed:

Figure 62. Extend Web Application to Another IIS Web Site

6. In Extend Web Application to Another IIS Web Site dialog select Create a 
new IIS web site and click OK.
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7. Go to Central Administration > Application Management >Configure 
Alternate access mapping and verify that the Default zone is assigned to the 
web application.

Figure 63. Default Zone
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8. In case default zone is not assigned to the web application, select the internal 
URL and change the zone to default.

Figure 64. Change to Default Zone

Post Default Port Settings
As a pre-condition user has to log on to the ACM Client using the port number. 

Perform the following procedure to change the port number for the ACM Client:

1. Close ACM Client application.

2. Go to Roaming folder. 

3. Delete OfflineAppData.xml file from the following location: 
C:\Users\800xAservice\AppData\Roaming\ABB\ACM 

4. Click on ACMClient.exe.

After changing the default port, logging on to ACM Client using the Windows 
credentials might not work.
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5. Enter URL in the following format:
ServerName:PortNumber 
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Appendix B  Error Messages

ACM creates error logs for basic exceptions, but there is also a provision to create 
advanced error logs for diagnostic purpose. The advanced error logging is disabled 
by default, to enable it, perform the following:

1. Go to the following path: 

C:\\<ProgramFiles(x86)>\ABB Industrial IT\Engineer IT\ACM\ACMBase\bin.

2. Open ACMClient.exe.config.

3. For the ErrorLog tag, set the Value to True.

4. Save and close the file.

Apart from these error logs following are the other possible errors that might occur 
while connecting to ACM server or working with ACM system: 

Table 4. Error Messages 

Error type Error Code Details

Conflict 409 The error message may 
occur:

• when the user tries to 
update a non-existent file, 
or the file path requested 
might not be valid.

• due to communication 
failure during creation of 
ACM system.

To rectify this error, delete the 
ACM system from ACM server 
and create it again.
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Bad request. 400 The error message may occur 
when the user requests with 
long URLs.

Internal server error. 500 The error message may occur 
when there is connectivity 
issues on server side.

Unauthorized access. 401 The error message may occur 
when the user tries to log in 
the ACM using wrong 
credentials.

Object check in failed. - This error message may occur 
if the object in 800xA system 
has inconsistencies.

Insufficient memory or Out of memory 
exception.

- This error message may occur 
when there is not enough 
memory available to ACM 
client application to perform 
the operations.

Remote name could not be resolved. - This error message may occur 
when the connection to the 
server and the client is not 
configured, or when the client 
fails to recognise the server.

- This may happen if the 
SharePoint Client Object 
Model Re-distributable is not 
installed in ACM client node.

Table 4. Error Messages (Continued)
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The operation has timed out. - This error message may occur 
when there is issue getting a 
response from sharePoint 
server. This is rarely seen 
while performing check out or 
check in operations.

- This error message may occur 
when check in of object\entity 
fails. 

Try the check in of 
object\entity once again.

HRESULT: 0x80131904

or

The remote server returned an error: (500) 
Internal Server Error.

- This error message may occur 
when the SharePoint 
database is full.

Table 4. Error Messages (Continued)
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Appendix C  Installation and Configuration of 
Microsoft SharePoint Foundation 2010 SP2 

Installation of SQL Express 2008 R2
To install SQL Express 2008 R2, do the following steps:

1. Download and install SQL Express 2008 R2 in window's authentication mode.

2. Launch SQL Server Management Studio from Main menu.

3. Enter the Server type, Sever name and Authentication in Connect to Server 
dialog, and Click Connect.

Microsoft SQL Server Management Studio screen is displayed.

4. In Microsoft SQL Server Management Studio, go to Database>System 
Database>Master>Security>Schemas.

5. Right click Schema and select New Schema.

 This appendix is applicable for standalone configuration with Database 
limitation of 10 GB.

For farm configuration ensure that SQL Server 2008 SP4 is installed, before 
installing Microsoft SharePoint Foundation 2010 SP2 and then, follow the 
procedure from SharePoint Foundation 2010 SP2 Installation on page 114.
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6. Enter Schema name as NT AUTHORITY\NETWORK SERVICE. 

Figure 66. Schema Name

Figure 65. Select New Schema
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7. Select Schema owner through browse, new Browser for Object dialog is 
displayed 

Figure 67. Search Roles and Users

Select [dbo] and click OK

8. In Microsoft SQL Server Management Studio Go to Database>System 
Database>Master>Security>Users

9. Create New user by right-click on new user and enter the user name and details 
as shown in screen shot.

Figure 68. Browse for Objects
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10. Confirm in created as above step and check for the Schema Owner, it should 

have been changed to NT AUTHORITY\NETWORK SERVICE

SharePoint Foundation 2010 SP2 Installation

Before proceeding with the Microsoft SharePoint Foundation 2010 SP2 installation, 
refer the Microsoft website for information on the hardware and software 
requirements.

To install and configure Microsoft SharePoint Foundation 2010 SP2 on Windows 
Server 2008 R2 Operating System, perform the following:

1. Enable .NET 3.5 feature using Operating System media (DVD). 

2. Double-click Sharepoint.exe.

Figure 69. Database User
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3. In the Microsoft SharePoint Foundation 2010 SP2 setup, click Install 
Software Prerequisites. For offline installation the prerequisites needs to be 
downloaded and installed manually, refer List of Prerequisites.

4. After the Prerequisites installation, click Install SharePoint Foundation. The 
wizard installs and configures the configuration database, the content database, 
and installs the SharePoint Central Administration website. This wizard also 
creates the SharePoint site collection. 

During the Microsoft SharePoint Foundation 2010 SP2 installation, for the 
Server Type choose Standalone and ensure that Run the SharePoint Products 
Configuration Wizard now check box is selected. 

5. In the SharePoint Central Administration website, to log on, enter the 
credentials of the administrator. 

6. Provide the server URL (for example, http://machine_name/) in the web 
browser to access and configure users in the SharePoint site. 

Add the web browser to the antivirus exception list, and add the Microsoft 
SharePoint Foundation server web link to the trusted sites of the web browser.

 

By default ACM Client establishes connection with ACM Server (SharePoint 
server) through 80 port. In case, ACM Server is configured on a different port 
(refer  Appendix A), same port must be added in Windows firewall exceptions.

List of Prerequisites

Download all the following prerequisites from the http://www.microsoft.com 
website and install them manually:
• Microsoft Chart Controls for Microsoft.NET Framework 2.5.
• Microsoft Filter Pack 2.0.
• Microsoft Server Speech Platform Runtime (x64).
• Microsoft Server Speech Recognition Language- TELE (en-US).
• Microsoft SQL Server 2008 Analysis Services ADOMD.NET.
• Microsoft SQL Server 2008 R2 Native Client.
• SQL 2008 R2 Reporting Services SharePoint 2010 Add-in.

http://www.microsoft.com/en-in/default.aspx
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SharePoint Foundation 2010 SP2 Configuration

1. After installing SharePoint Foundation 2010 SP2, select SharePoint 2010 
Central Administration from the Start menu.

2. Select Central administration, under Application Management click Manage 
content data base.

3. Click database name, and check Remove Content database and click OK

Figure 70. Remove Content Database

Content database gets deleted

4. Select Central administration, under Application Management click Manage 
web applications.

5. In Manage web applications , select SharePoint-80 and delete that web 
application

6. Select Central administration, click Application Management.

7. Under Site Collections select Specify quota templates. 

Following Quota template screen is displayed:



Figure 71. Quto Template
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8. In new quota template, set the limit site storage to the maximum of <10GB, 

Click OK.

9. Select Central administration, click Application Management.

10. Under Databases, click Specify the default database server.



Figure 72. Default Database Sever
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11. In the default database server page give the database servername as given in the 

SQL server instance name. Click OK

12. Under Web application, click Manage Web applications.

13. In web applications page create new web application; New web application 
creation page gets opened.



Figure 73. Create New Web Application
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14. In Database Name and Authentication field, Database server name should be 

same as of the SQL server Instance name and database can be default.

15. In search server section, select the share point server name from drop down list 
and click OK.

Once the new web application is created, New Database is created under Database 
of SQL server Instance.

16. Open the Microsoft SQL server Management studio and select the newly 
created database and open properties.
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17.

Figure 74. Database Properties

Select the Files property and set the Database size to 10GB and select OK.

In SharePoint central administration, once the web application is created, create site 
collection for that particular web application and select the quota Template for that 
team site.

This Site can be used for ACM operations.

To Check Database Size in ACM Server
Perform the following:

1. In the Start menu, click SharePoint 2010 Central Administration. 

2. Click Application Management. 
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3. Under Site collections click Configure quota and locks. The size of the 
database is displayed as shown in Figure 75.

Figure 75. Size of Database
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Appendix D   Change Reporting Features

Application Change Management 5.1.4-1/1A Functionality______________________________________________

 

 The features in this appendix requires 800xA and ACM server to be in the same 
domain.

ACM also supports change reporting for System 800xA by enabling the support for 
check in of various system specific reports to the ACM Server. These reports can be 
generated on a scheduled basis and used to report system configuration states.

Check In Support to ABB Diagnostic Collection Tool 
(DCT) Report

ACM supports checking in the contents of ABB Diagnostic Collection tool default 
folder (.cab files) to ACM server. When the tool is run on a 800xA node, it collects 
information of the installed products in the system and stores the same in .cab file 
format in a folder at a predefined location. It is possible to check in all the .cab files 
to ACM server at a pre-defined path as follows: 

http://<ACMServerURL>/<800xASystem name>/ConfigData.

Pre-requisite

• Diagnostic collection tool must be installed on the 800xA node and tool report 
must be created.

For more information on Diagnostic Collection Tool, refer to System 800xA Tools 
(2PAA101888*).

Checking In .cab File to ACM Server

Follow the procedure to check in .cab file into ACM server:

1. Go to Start > Run and enter cmd, and click OK.
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2. Select ACMReportGen.exe from ACMBase/Bin folder and move it into 
command prompt by a drag-and-drop action.

3. Type http://ACMServerURL -P -DC and press Enter.

System name can be considered from the following location: 

C:\Users\<Windows username>\AppData\Roaming\ABB\ACM

 

Data Successfully Transferred message appears in the command prompt.

4. Start Internet Explorer and navigate to configData folder of corresponding 
ACMSystem in ACMServer.

A .cab file for DCT report gets checked in. 

The windows automatic task scheduler can also be used to schedule automatic 
check in operations periodically. This can be done using the standard procedure 
to configure the Windows Scheduler. For more information, refer to the following 
website: 

http://windows.microsoft.com

 

The subsequent check in of DCT Report overrides the previous version.

Check In Support for System Report
Various reports generated in the 800xA node can be checked in to the ACM server. 
Follow the procedure to check in system report into ACM server:

1. Go to Start > Run and enter cmd, and click OK.

2. Drop ACMReportGen.exe from tools folder into command prompt.

3. Type http://ACMServerURL -P -SD and press Enter. 

System name can be considered from the following location: 
C:\Users\800xaservice\AppData\Roaming\ABB\ACM

Data Successfully Transferred message appears in the command prompt.

http://windows.microsoft.com
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4. Start Internet Explorer and go to ACM server, SystemData.xml file is created 
under ConfigData section. 

The subsequent check in of System Report overrides the previous version.

Check in Support for Security Report Aspect
Blob data of security report aspect is extracted under system object in Admin 
structure and the data is copied in to a rich text file (.rtf) and the file is checked in to 
ACM server. Follow the procedure to check in system report into ACM server:

1. Go to Start > Run and enter cmd, and click OK.

2. Select ACMReportGen.exe from ACMBase/Bin folder and move it into 
command prompt by a drag-and-drop action.

3. Type http://ACMServerURL -P -SR and press Enter. 

System name can be considered from the following location: 
C:\Users\800xaservice\AppData\Roaming\ABB\ACM

Data Successfully Transferred message appears in the command prompt.

Start Internet Explorer and go to ACM server, SecurityReport.rtf file is created 
under ConfigData section. 

Check In of Hardware Inventory Report
It is possible to check in the Hardware Inventory Reports of all connected AC 800M 
controllers to the connected ACM Server. These reports are generated by 'AC800M 
Fingerprint' tool. The tool to collect the controller data and prepare the reports must 
be installed and run separately on any one of the connectivity servers or the client 
which has access to the connected controllers and has ACMClient installed.

Once the reports are created, ACM shall check in the same to ACM Server in 
compressed form. There must be only one version created for Hardware Inventory 
Reports. Therefore, the subsequent checkin will overwrite the previously checked in 
reports. Once the reports are created, same will be checked in to ACM Server.

The subsequent check in of Security Report Aspect overrides the previous 
version.
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Follow the procedure to check in Hardware Inventory Report into ACM server:

1. Go to Start > Run and enter cmd, and click OK.

2. Select ACMReportGen.exe from ACMBase/Bin folder and move it into 
command prompt by a drag-and-drop action.

3. Type http://ACMServerURL -P -HWI and press Enter. 

System name can be considered from the following location: 
C:\Users\800xaservice\AppData\Roaming\ABB\ACM

Data Successfully Transferred message appears in the command prompt.

Start Internet Explorer and go to ACM server, Hardware InventoryReport.txt file 
is created under ConfigData section.  

Check In Support for Miscellaneous Files
Various miscellaneous files such as .xlsx, .xml/.xml.gx, .afw etc. in the 800xA node 
can be checked in to the ACM server, follow the procedure to check in 
miscellaneous file into ACM server:

1. Select any miscellaneous file in the System.

2. Go to Start > Run and enter cmd, and click OK.

3. Drop ACMReportGen.exe from tools folder in to command prompt, and type 
http://ACM server name -P <filepath>

4. Type the location of the file in the command prompt, for example, 
C:\Sample1.doc and press Enter. 

System name can be considered from the following location: 
C:\Users\800xaservice\AppData\Roaming\ABB\ACM

Data Successfully Transferred message appears in the command prompt.

The subsequent check in of Hardware Inventory Report Aspect overrides the 
previous version.

For more information on "AC 800M Fingerprint", contact ABB SupportLine.
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5. Start Internet Explorer and go to ACM server, a miscellaneous file is created 
under ConfigData section. 

The windows automatic task scheduler can also be used to schedule automatic 
check in operations periodically. This can be done using the standard procedure 
to configure the Windows Scheduler. For more information, refer to the following 
website: 

http://windows.microsoft.com

 

Only one version of Miscellaneous files could be checked in to the ACM Server.

___________________________________________________________________________________________

http://windows.microsoft.com
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Appendix E   Configuration of ACM Service in 
Different Domain Controller

Application Change Management 5.1.4-2 Functionality______________________________________________

 

 This appendix is applicable for secure configuration and communication of 
ACM services across different domain controllers.

 

ACMScheduler functionality is not supported across different domains.

ACM support has been extended to allow secure cross domain communication. This 
means that the ACMClient can be connected to an ACMServer which is configured 
in different domain controller.

For example:

Aspect System 1 and ACMServer1 are configured in domain controller DC01.

Aspect System 2 and ACMServer2 are configured in domain controller DC02.

In the above scenario, the ACMClient configured on Aspect System 1 can now be 
connected to ACMServer2.

To establish secure cross domain communication, certain configurations and 
settings are required on the ACMServer and the ACMClient nodes. These are one 
time settings and are explained in the following sections.

ACMServer Node

Configuring Certification Service

In order to establish secure connection of ACM across different domain controllers, 
Active directory Certificate services must be configured on the ACM Server node.

To configure Certification Service, do the following steps on ACM Server:
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1. Open Windows Add Roles wizard. Select Server Roles select Active 
Directory Certificate Services.

2. Follow the instruction and click Next.

3. Select Certification Authority on the Select Role Services dialog or window.

4. Select Setup Type and then select Enterprise.  

5. Click Next.

6. Select Root CA in the Specify CA Type window.

7. Click Next.

8. Select Create a new Private key and click Next.

9. Select Cryptographic Service Provider (CSP) from the drop-down list, 
Figure 76. 

Figure 76. Add Roles Wizard

 

10. Click Next.
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11. Configure CA Name window appears. Retain the default text in all the fields. 
Follow the instructions and click Next.

12. Select Validity Period and then select the period from the drop-down list.

13. Click Next.

14. Select Confirmation.

15. Click Install and wait for its completion.

16. Click Close.

Creating a Secure Site in SharePoint Foundation 2013 

To create a secure site in SharePoint Foundation 2013, do the following steps:

1. Open SharePoint Central Administration site from Start> All Programs> 
SharePoint Foundation 2010.

2. Go to Application Management>Manage Web Application>New.



Creating a Secure Site in SharePoint Foundation 2013Appendix E  Configuration of ACM Service in 

132 2PAA108438-510 B

3. Select Yes radio button in the Use Secure Socket Layer as shown in Figure 77.

Figure 77. Creating New Web Application

4. Click OK.
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Creating Domain Certificate

To configure and create domain certificate, do the following steps on ACM Server:

1. Open Internet Information Services and select Server Name.

2. Double-click Server Certificates, Figure 78.  

Figure 78. Select Server Certificates
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A window appears as shown in Figure 79. 

Figure 79. Internet Information Service Manager window

3. Click Create Domain Certificate.

4. In the Distinguished Name Properties window, enter the machine name in the 
Common Name field, for example: CRPCBVM2 and fill the other details 

5. Click Next.

6. In the Specify Online Certification Authority field, click select and choose 
the certification authority from the list.

7. In the Friendly_name field, enter a unique name.
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8. Click Finish. New certificate is updated in the server certificate list as shown in 
Figure 80. 

Figure 80.  Server Certificates window
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9. Select the SharePoint Secure site from the Sites folder of IIS and click 
Bindings. The Site Bindings window appears as shown in Figure 81. 

Figure 81. Certification Authority

10. Click Edit.The Edit Site Binding window appears.

11. Enter the Host name that is same as the common name given in certificate (for 
example, crpcbvm2).

12. From the SSLCertificate drop-down menu, select the certificate and click OK. 
The Site Bindings window appears as shown in Figure 82. 

Figure 82.  Site Bindings window
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ACMClient Nodes

Installing Certificate on ACMClient Nodes

In order to connect ACMClient to the secure ACM Server across different domain, 
SSL certificate must be installed on the ACMClient node. Installing SSL certificate 
on the ACMClient node requires the certificate to be exported from the ACM 
Server. 

Export Root certificate from ACM Server:

1. Enter mmc in Run command of the ACM Server to launch Microsoft 
Management console. 

2. Go to File menu and select Add/Remove snap-In.

3. Add Certificates in the console root and expand the Personal folder.

4. Navigate to Certificates> Personal>Certificates, Figure 83. 

Figure 83. Microsoft Management console
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5. Right-click the certificate to be exported and select All Tasks> Export. the 
Certificate Export Wizard window appears as shown in Figure 84. 

Figure 84. Certificate Export Wizard window

6. Click Next.



Appendix E  Configuration of ACM Service in Different Domain Controller Installing Certificate on 

2PAA108438-510 B 139

7. Select No, do not export the private key and click Next as shown in 
Figure 85. 

Figure 85. Certificate Export Wizard window
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8. Select the format as DER encoded binary X.509 (.CER) as shown in 
Figure 86. 

Figure 86. Certificate Export Wizard window

9. Click Next.

10. Click Browse and provide the appropriate name.

11. Click Next.

12. Click Finish. The export is successful message is displayed.

13. Install SSL certificate on ACMClient node.

14. Copy the exported certificate to C:\Program Files (x86)\ABB Industrial 
IT\Engineer IT\ACM\ACM Base\bin.

15. Open ACMClient.exe.Config file with Notepad from the above location.
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16. Update the copied certificate name along with its location path in the 
‘Certificate’ as follows:

<add key="Certificate" value="C:\Program Files (x86)\ABB Industrial 
IT\Engineer IT\ACM\ACM Base\bin\ACM.cert"

17. Open the Microsoft Management console (mmc) and follow Step 1 to Step 4.

18. Right-click the certificate folder and click Import.

19. Provide the certificate path mentioned in Step 14 and follow the instructions.

20. Launch ACMClient.exe by double-clicking ACMClient.exe. ACM login 
window appears as shown in Figure 87. 

Figure 87. Login Window

21. Enter the ACM Server name in the Server URL field. For example, 
https://esl4vm03-acm.

22. Clear the Windows Login check box.

23. Enter the User Name in the format Domain\user name and Password.

24. Click Login.
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___________________________________________________________________________________________

ACM workflows remain same. Refer corresponding sections for more 
information.



Appendix F  Adding ACM Service in a Running System 800xA

2PAA108438-510 B 143

Appendix F   Adding ACM Service in a 
Running System 800xA

This appendix describes the procedure to configure and add Application Change 
Management (ACM) service into a running System 800xA 6.0 and later revisions. 
The proposed system configuration to add a dedicated ACM feature node, is 
prioritizing online integration of the features and optimizes the configuration in 
regard to integrity of the Application Change Management feature. Feature mixes 
on nodes are supported but may limit the option to add the feature while operating 
the plant.

To configure and add Application Change Management (ACM) service into a 
running System 800xA, do the following steps on the node that is selected to run the 
ACM Service:

1. Add a new node to the System 800xA network with Microsoft Windows Server 
2008 R2 operating system.

2. Login to the node with user having administrator permissions, preferably an 
'800xA service' account.

3. Install SQL Server 2008 SP4 available in ABB System 800xA media.

4. Download and install the prerequisites of SharePoint Foundation 2010 SP2. 

5. Download and install SharePoint Foundation 2010 SP2. Refer to Appendix C, 
Installation and Configuration of Microsoft SharePoint Foundation 2010 SP2.

6. Configure security (network service account, System 800xA users).

7. Run Product Configuration Wizard of SharePoint Foundation (if not run as part 
of SharePoint Installation). Refer to Appendix C, Installation and 
Configuration of Microsoft SharePoint Foundation 2010 SP2.

8. Open 'SharePoint 2010 Central Administration' from All Programs> 
Microsoft SharePoint 2010 Products and configure the System 800xA users.
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Do the following steps with Service account user, on the nodes where ACMClient is 
intended:

1. Install Pre-requisite on Client nodes from the Application Change Management 
folder of System 800xA media.

2. Install Application Change Management (ACM) on Aspect Servers from above 
mentioned path.

3. Load System Extension named ABB ACM.

4. Load system extension ABB ACM for Engineering Studio (in case 
Engineering Studio extensions are loaded).

5. Install Application Change Management (ACM) on intended client nodes.

6. Launch ACM application by double-clicking the desktop icon named 
ACMClient.

7. Provide the ACM Server name and user credentials in the ACM login window.

8. Create ACM System by clicking Actions> Create ACM Server.

9. Do the user’s configuration based on the intended roles. 

For more information on ACM, refer to System 800xA Application Change 
Management (2PAA108438*).
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Revision History

 

 The following table lists the revision history of this User Manual. 

The revision index of this User Manual is not related to the 800xA 5.1System 
Revision.

Revision 
Index

Description Date

A Updated for 800xA Application Change Management 5.1.4-1 
and 5.1 FP4 Rev E.

July 2015

B Updated for 800xA Application Change Management 5.1.4-2 January 2016
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Updates in Revision Index A
The following table shows the updates made in this User Manual for 5.1.4-1 and 5.1 
FP4 Rev E.

Updated Section/Sub-section Description of Update

Section 1, Application Change Management, Replaced the image for Figure: Sample ACM View

Section 2, Starting ACM for the First Time, Changed step 8 from:
In the MaxVersions dialog box, set the maximum 
number of versions of an object/entity.
To
In the General Settings dialog, set the maximum 
number of versions and enable .xml compression 
and aspect support (if required).
Added the following note:
If General Settings are not required, click Close. 
This ensures that there is no limit on the maximum 
number of versions. For more information, refer 
General settings.

Section 2, User Interface  Added an entry in the table User Interface of 
ACM Client as follows:
10: Indicates if the connection to ACMServer is 
encrypted or unencrypted

Section 2, User Interface Added the following note:
Deleting entities which are checked in as part of 
dependencies may result in failure of Get Latest 
with dependencies.
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Section 2, User Interface Replaced the image for Figure: Status View
Added a new Table: Button description
Added the following information:
All the old messages get deleted on reopening the 
ACMClient.

Section 2, Menus Added bullet points under Edit: 
General Settings
Scheduler settings 

Section 2, Menus Added the following note:
After creating a system baseline, the activity log is 
shown only for the date on which the baseline is 
created. All the previous logs are moved to the 
baseline.

Section 3, Configuration Added the following Subsections:
• Check In Support for Aspects Associated 

with an Object

• Check In of Asset Optimization (AO) Aspects

• Check In of Log Templates and Trend 
Templates

• Check In of Foundation Fieldbus (FF) 
Management Aspects

• Check In of Log Configuration and Trend 
Display Aspects

• Check In of PG2 Graphic Aspects

• Check In Support for OPC Control 
Connection

Updated Section/Sub-section Description of Update
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Section 3, Baseline Added the following note:
Creating a baseline is allowed only to an Admin 
user. The Admin user has to ensure that no fur-
ther modifications or ACM operations are per-
formed during baseline creation. This is aligned 
with System 800xA behavior where it is assumed 
that configuration changes are not performed 
while taking the system backup.

Section 3, General Settings Updated this section with new image: General 
Settings.

Section 3, Custom Entities Updated the Configure section with new image: 
Custom Entity Configuration and the relevant sec-
tion

Section 3, To add a Custom Entity Replaced the image: Custom Entity Configure 
Window

Section 4, ACM Scheduler This section is newly added.

Section 5, Security in ACM Server Added a note: If the user is not listed in ACM 
server User configuration, user should be added 
from the ACM server.
Added a topic: To add users in ACM Server.

Appendix A Changing Default Port This section is newly added.

Appendix A Changing Default Port Added a new Topic: Post Default Port Settings.

Appendix B Error Messages This section is newly added.

Appendix C Microsoft SharePoint Foundation 
2010 SP2 

This appendix is newly added.

Appendix D Sharepoint Server Configuration This appendix is newly added.

Appendix E Change Reporting Features Page This appendix is newly added.

Updated Section/Sub-section Description of Update



  

2PAA108438-510 B 149

 

Updates in Revision Index B
The following table shows the updates made in this User Manual for 5.1.4-2.

Updated Section/Sub-section Description of Update

Section 2, Basic Operation Added the following new subsection:

• Exporting Activity Log to Excel Sheet

Section 3, Configuration Modified the following subsections:

• Creating baseline 

• Loading a Baseline 

Appendix E, Configuration of ACM Service 
in Different Domain Controller

This appendix is newly added.

Section 3, Configuration, To Check In an 
Object

Replaced the image for the following figure:
Check In Confirmation Message

Section 2, Basic Operation, Menus, View Added the following sub-section:

ACM Server Info

Changed the title from Activity Log to ACM Activity 
Log

Section 2, Basic Operation, Menus, View Added the following information:

• xml, xlsx and gz file count is displayed only if 
XML/XLS support is enabled.

• Current storage used in ACM Server requires 
ACM owner role. To do this: Change the logged 
in user from Action> Change ACM Server

Section 2, Basic Operation, Starting ACM 
for the First Time

Replaced the image for the following figure:
Login to Access
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Appendix B, Error Messages Updated the following for error type Conflict:
The error message may occur:

• when the user tries to update a non-existent file, 
or the file path requested might not be valid.

• due to communication failure during creation of 
ACM system.

To rectify this error, delete the ACM system from ACM 
server and create it again.

Section 3, Configuration Added the following sub-section:
Check in with Change Request Document 

Section 2, Basic Operation, User Interface The following information is added:
In some cases, logged in user in ACMClient is dis-
played as SharePoint/System. To correct this, do the 
following steps in ACM Server:
1.Open SharePoint Central Administration from All 
Programs> Microsoft SharePoint 2013 Products.
2. Select Security > General Security> Configure 
Service Account.
3.Select the SharePoint Site (for example, Web Appli-
cation Pool - SharePoint-80) and then select Network 
Service from the Select account for this component 
drop-down list.
4.Click OK.

Section 2, Basic Operation, Tools ACM Server renamed to ACM System

Section 2, Basic Operation, Menus Change User renamed to Change ACM Server

Updated Section/Sub-section Description of Update
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Section 2, Basic Operation, Actions, 
Change ACM Server

The following bullet points added:
• This can be used to switch the user within the 

same ACM Server based on the requirement.

• This can be used to switch to a different ACM 
Server by providing the name and credentials of 
the intended ACM server in the respective fields.

Added the following information:

For connecting an ACM server which is configured in 
different domain controller, specified workflow has to 
be followed, refer Appendix F, Configuration of ACM 
Service in Different Domain Controller.

Appendix C, Installation and Configuration 
of Microsoft SharePoint Foundation 2010 
SP2

This appendix is newly added.
This is a merged appendix.

Appendix E, Configuration of ACM Service 
in Different Domain Controller, Configuring 
Certification Service

Deleted the following information:
If Enterprise option is disabled, select Standalone.
Added the following information:
ACMScheduler functionality is not supported across 
different domains.

Updated Section/Sub-section Description of Update
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Section 1, Introduction, Entities Hierarachy Replaced the following figure:
Control Project
Added the following information:
Control Project in System 800xA consists of Applica-
tions and Controllers folders to hold different applica-
tions and controllers configured in the same project.
Each application consists of Application Types, Con-
trol Modules, Programs and Diagrams. An individual 
.afw file is created for each application that includes 
Application Types, Control Modules, and Programs. 
However, a separate .afw file is created for Diagrams 
as they are defined as separate entities.
Similarly all the controllers configured under the proj-
ect are checked in as individual .afw files.

Section 1, Introduction, Multiple System to 
Dedicated ACM Servers

The following information has been added:
The 800xA systems and the ACM server requires 
secure communication if they are configured in differ-
ent domain. Refer to Appendix E, Configuration of 
ACM Service in Different Domain Controller for more 
information.

Appendix D, Change Reporting Features The following information has been added:
The features in this appendix requires 800xA and 
ACM server to be in the same domain.

Section 2, Basic Operation Added the following subsection:
ACM Server Info

Section 2, Introduction, Prerequisites Deleted the following information:
The 800xA system and the ACM server must be con-
figured in the same domain.

Appendix F Added the following new appendix:
Adding ACM Service in a Running System 800xA

Updated Section/Sub-section Description of Update
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Section 1, Entities Hierarchy Added information on Library, HSE Subnet

Section 1, Introduction General updates.

Section 2, Basic Operation Object View and Version History View Images 
replaced.

Updated Section/Sub-section Description of Update
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